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Statement of Creditable Sea Service (SOCSS) 

Overview 

 
Introduction The purpose of this guide is to provide the foundation to request a complete and 

accurate Statement of Creditable Sea Service (SOCSS) from PPC. 

 
SOCSS vs. TOSS A Statement of Creditable Sea Service (SOCSS) is NOT a Transcript of Sea Service 

(TOSS).  It is important to know the difference:   

 

• A SOCSS is a process used by PPC to account (not correct) for Out-of-Range 

creditable sea time and ensure the accurate data compiled on the PPC-1072 

reflects in Direct Access (DA).  A SOCSS must be completed prior to MAS 

adjusting career sea pay (CSP).   

 

• A TOSS is a request of dates a member was attached to a sea going vessel 

regardless of whether they received career sea pay or not.  The sole purpose of a 

TOSS is for the member to obtain a Merchant Mariner license.  

 

NOTE:  It is also important to remember that the dates of sea time may not match 

between a SOCSS and a TOSS for a variety of reasons. 

 
IMPORTANT It is important to review this guide in its entirety to ensure all you capture everything 

needed to submit a SOCSS Request. 

 

95% of all SOCSS requests are returned to the SPO due to missing TDY data and 

incorrect or missing Neutral Rows.  It is the SPO’s responsibility to ensure all data is 

entered in DA and is correct prior to submitting a SOCSS request.  PPC will not 

process incomplete or incorrect SOCSS requests.  Incomplete or incorrect SOCSS 

requests will be closed and unworked and the SPO will be notified of what must be 

completed prior to resubmitting a SOCSS request.    
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Statement of Creditable Sea Service (SOCSS) 

 
Introduction The section provides definitions, references, helpful links, and guidance on how to 

request a Statement of Creditable Sea Service (SOCSS) from PPC. 

 
References  (a) Coast Guard Pay Manual, COMDTINST M7220.29 (series), Chapter 4.B.4 

(b) Personnel and Pay Procedures Manual (3PM), PPCINST M1000.2 (series), 

Chapter 6.J.4 

 
Helpful Links (a) JUMPS Data Repository User Guide 

(b) PCS Orders Guide  

(c) Career Sea Pay User Guide 

(d) Element Assignment By Payee (EABP) User Guide 

(e) CG Member Info Report 

 
When to Request 

a SOCSS 
The P&A Office must submit a SOCSS request to the PAO when a member’s sea 

time is incorrect. The Servicing Personnel Office (SPO) must request a SOCSS from 

PPC when, after a complete review of sea time following the guidelines outlined in 

this document have been completed, and sea time has been found to be incorrect.   

 

NOTE 1:  Do not ignore suspected sea time errors simply because a member is not 

currently assigned to a career sea pay eligible vessel.  

 

NOTE 2:  If there is a discrepancy in career sea pay dated prior to January 1, 2015, 

the SPO Payment Approving Official (PAO) needs to certify the member is/was 

entitled to Career Sea Pay (the actual dates) IAW reference (a) “Career Sea Pay” of 

the Pay Manual for any and all pre-DA sea pay/time issues.    

 
How to Request a 

SOCSS 
Complete the SOCSS Checklist.  Once all information has been verified and the 

SOCSS Checklist has been completed and signed by a YN1or above with PAO 

designation at the member’s SPO, attach the completed SOCSS Checklist and all 

other Required Documents to the PPC ticket requesting the SOCSS.  

 

If the SOCSS request is missing any Required Documents, including a signed/dated 

SOCSS Checklist, the SOCSS request will be returned to the SPO and the ticket will 

be closed with no action taken.         

 

Continued on next page 

https://media.defense.gov/2019/Nov/15/2002211440/-1/-1/0/CIM_7220_29D.PDF
https://www.dcms.uscg.mil/Portals/10/CG-1/PPC/PPPM/TTP/3PM%20TTP%20-%20Chapter%206.pdf
https://www.dcms.uscg.mil/Portals/10/CG-1/PPC/PPPM/TTP/3PM%20TTP%20-%20Chapter%206.pdf
https://www.dcms.uscg.mil/Portals/10/CG-1/PPC/GUIDES/GP/PPC/JUMPSDataRepository.pdf?ver=2017-05-08-110450-680
https://www.dcms.uscg.mil/Portals/10/CG-1/PPC/GUIDES/GP/SPO/PCS/PCS%20Orders.pdf
https://www.dcms.uscg.mil/Portals/10/CG-1/PPC/GUIDES/GP/SPO/Earnings/Career%20Sea%20Pay.pdf?ver=YJekN9lWXeIWmFDLdK1mqQ%3d%3d&timestamp=1614284190146
https://www.dcms.uscg.mil/Portals/10/CG-1/PPC/GUIDES/GP/SPO/Earnings/EABP.pdf?ver=2019-07-01-151820-917
https://www.dcms.uscg.mil/Portals/10/CG-1/PPC/guides/gp/selfservice/command/Self%20Service%20for%20Command%20-%20Member%20Info%20Report.pdf
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Statement of Creditable Sea Service (SOCSS), Continued 

 

How to Request a 

SOCSS, continued 
For all SOCSS requests, the SPO must contact PPC Customer Service via an online 

trouble ticket or send an email to PPC-DG-customercare@uscg.mil and provide the 

following information (see Required Documents and Formatting Required 

Documents): 

• Member's Employee ID and full name 

• Responsible SPO’s Department ID 

• A descriptive narrative as to the problem as well as the reason for the SOCSS 

request  

• Completed SOCSS Checklist 

• SEG 07 Excel Spreadsheet (if applicable) 

• SEG 69 PDF (if applicable) 

• Any additional documentation to support the SOCSS request (i.e., Prior Service 

DD-214s with Navy time, No Cost Orders with no travel claim filed, etc.). 

 

NOTE:  Per the 3PM, do not request a SOCSS completion status less than 120 days 

from the initial request date.  The SPO will file a copy of the SOCSS request in the 

member's PDR, section 1, to serve as supporting documentation for adjusting the 

member’s sea time. 

 
Required 

Documents 
When submitting a SOCSS request, PPC requires the following documentation: 

• SOCSS Checklist (verified and signed by PAO) 

• CG Member Info (CGMI) Report 

• PCS Orders  

• No Cost Orders 

• TDY Travel Claims  

• PCS Travel Claims  

• SEG 07 Excel spreadsheet (if applicable) 

• SEG 69 Screenshot (if applicable) 

 

It is VITAL the information contained in Direct Access (DA) is up to date and 

correct prior to submitting a SOCSS request to PPC.   

 

NOTE:  See the SOCSS Checklist for exceptions to required documents. 

 
Formatting 

Required 

Documents 

When submitting scanned documents as part of the SOCSS request, it is 

recommended that each scanned document begin with the member’s Employee ID 

(EMPLID).  For example:   

• 1234567 – SOCSS Checklist 

• 1234567 – CGMI 

• 1234567 – TVL Claim dtd 05/01/18 

• 1234567 – No Cost Orders dtd 07/21/18 

• 1234567 – SEG 07 

• 1234567 – SEG 69 

 

mailto:CustomerCare.PSC@uscg.mil?subject=SOCS%20Request%20EMPLID&body=Dear%20PPC%20Customer%20Care
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SOCSS Additional Information 

 
Introduction This section provides information on the importance of gathering and verifying 

accurate data prior to requesting a Statement of Creditable Sea Service (SOCSS) 

from PPC.   

 
Neutral Rows The accuracy of neutral rows in DA is VITAL.  Complete the following:   

• Review each neutral row to ensure all start and stop dates are accurate.  

• Ensure there are no missing neutral rows. 

• Review the start and stop dates for all TDY periods. 

• Review the start and stop dates for all PCS orders. 

 
Sea Time and 

Direct Access 
All sea time must be accounted for in DA.  If there is missing TDY in DA, the SPO 

or Unit must input that period of time into DA as CSP for TDY, even if Out-of-

Range and even if already on a ship.  Remember, even one day off in DA is a 

problem and could result in the member’s Career Sea Pay Premium being incorrect.   

 

If there is an error, an entry should be made in DA (CSP for TDY) to reflect the 

correction (see NOTE). 

 

NOTE:  If a transaction is Out-of-Range, the affected period includes dates OLDER 

than 24 pay periods or one year.  An Out-of-Range CSP for TDY transaction requires 

a PPC Customer Care ticket.  To complete an Out-of-Range transaction: 

1. Enter the transaction into DA 

2. Approve the transaction in DA 

3. Submit a ticket to PPC Customer Care with the following information: 

• Member’s name/rank 

• Member’s Emplid 

• Name of Entitlement 

• Effective Dates 

• Name and Emplid of SPO Auditor 

• Reason the transaction was submitted Out-of-Range 

• Screen shots of any deleted rows 

• Transaction details 

• The date the transaction was approved 

• Detailed pay adjustment (if needed) 

Continued on next page 

https://www.dcms.uscg.mil/Portals/10/CG-1/PPC/GUIDES/GP/SPO/Earnings/Career%20Sea%20Pay.pdf?ver=YJekN9lWXeIWmFDLdK1mqQ%3d%3d&timestamp=1614284190146
https://www.dcms.uscg.mil/Portals/10/CG-1/PPC/GUIDES/GP/SPO/Earnings/Career%20Sea%20Pay.pdf?ver=YJekN9lWXeIWmFDLdK1mqQ%3d%3d&timestamp=1614284190146
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SOCSS Additional Information, Continued 

 
Sea Time and 

JUMPS  
All sea time earned prior to January 1, 2015 must be accounted for in the Joint 

Uniform Military Pay System (JUMPS) (see the JDR archive), and reviewed for 

accuracy (e.g., SEG 07s and SEG 69s). 

 

If there is an error, an entry should be made in DA (CSP for TDY) to reflect the 

correction (see NOTE). 

 

Example 1:  SEG 07 shows consecutive sea time from 01 Jan 2000 – 30 Apr 2000 

but the member’s TDY travel claim to the CGC Munro shows the member got off the 

ship 29 Apr 2000.  Since JUMPS can no longer be corrected, the correct dates of the 

entire TDY period should be reflected in DA (CSP for TDY). 

 

Example 2:  SEG 07 shows consecutive sea time from 01 Jan 2000 – 30 Nov 2003, 

but a TDY travel claim is found in ETS that shows the member was TDY away from 

the CGC MUNRO for more than 30 days and there is no neutral row in JUMPS or 

DA.  A neutral row must be entered into DA to reflect the stoppage of sea time / 

career sea pay.  

 

Example 3:  A SEG 69 (correction to sea time) was found while the member was 

attached to the CGC Munro adding another 30 days of sea time starting on 01 Dec 

2003 and running through 30 Dec 2003.  This adjustment by the SEG 69 will be 

reflected on the PPC-1072 so no action is needed by the SPO unless the entry is 

determined to be incorrect after review. 

 

NOTE:  If a transaction is Out-of-Range, the affected period includes dates OLDER 

than 24 pay periods or one year.  An Out-of-Range CSP for TDY transaction requires 

a PPC Customer Care ticket.  To complete an Out-of-Range transaction: 

1. Enter the transaction into DA 

2. Approve the transaction in DA 

3. Submit a ticket to PPC Customer Care with the following information: 

• Member’s name/rank 

• Member’s Emplid 

• Name of Entitlement 

• Effective Dates 

• Name and Emplid of SPO Auditor 

• Reason the transaction was submitted Out-of-Range 

• Screen shots of any deleted rows 

• Transaction details 

• The date the transaction was approved 

• Detailed pay adjustment (if needed) 

Continued on next page 
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SOCSS Additional Information, Continued 

 
JUMPS Segments SEG 07 – Identifies PCS and TDY sea time / career sea pay credited to the member. 

 

SEG 69 – Shows an adjustment (positive or negative) to the sea time listed in SEG 

07. 

 

Recommendation:  Convert the SEG 07 to an Excel Spreadsheet and using the JDR 

to Excel Macro User Guide attached to the end of this user guide, format the SEG 

07/spreadsheet for easier comprehension.  SEG 69 does not need to be converted, 

simply print it as a PDF and attach it to the PPC Ticket (even if the SEG 69 is blank, 

attach it to speed up the auditing process at PPC).    

 
30 Day Rule It is important to understand the 30-day rule and how the 30-day rule applies to 

Tactical Law Enforcement Teams (TACLETs), Cutter Response Teams, and Afloat 

Training Organizations (ATOs) (see reference (a), chapter 4.B for more information 

on the 30-day rule as it applies to Career Sea Pay (CSP), Career Sea Time (CST), and 

Mobile Units). 

 

The 30-day rule starts at 0001 of the first full day the member is TDY away from the 

CSP-eligible vessel.  CSP and CST accrual terminates at 2400 the 30th actual day the 

member is TDY away from the CSP-eligible vessel. 

 

Periods of leave taken before, after, or between two periods of TDY by members 

permanently assigned to a CSP-eligible vessel must be considered when computing 

the 30-day period.  Remember:  Members are entitled to CSP / CST accrual for all 

periods of excused absence and TDY up to 30 days. 
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SOCSS Checklist for Member:          _             EMPLID:_____    

Print SOCSS Checklist.  Initial the Completed box as each Action is reviewed and completed, as necessary.  Sign and Date 
the SOCSS Checklist.  Scan signed SOCSS Checklist and attach to SOCSS request to PPC.  Upload to IPERMs. 
 
The P&A should collect and review the information prior to submitting it to the SPO.  For all SOCSS requests, an E-6 or 
above in the member’s SPO must contact PPC Customer Care via an online trouble ticket or send an email to PPC-DG-
Customercare@uscg.mil. 
 

** By signing this document, you, as the PAO, are certifying that all information provided to support this SOCSS 
request is true beyond a reasonable suspicion of doubt. ** 

Completed Action Description 

 Review PCS Start and Stop 
dates for accuracy.  
 

• Prior to 01/01/2015 – Compare SEG 07 and SEG 69 with PCS 
Orders and PPC approved/finalized travel claims. 

• 01/01/2015 to Present – Review PCS Orders in DA. 

 Review ALL neutral rows and 
ensure the dates are accurate.   
 

Neutral row dates should reflect the accurate dates based on the PCS 
arrival and departure dates to a ship and should include the 30-day 
rule when TDY.  If neutral rows are entered for a period of dry dock 
time, include exact dates in your SOCSS request to help PPC verify 
the reason for the neutral row. 

 Provide an explanation Include an explanation of any start/stop of sea time that is NOT 
accounted for by a neutral row and/or is not obvious (e.g., no cost 
orders, ship to ship transfers). 

 Review EABP • Review member’s EABP rows for ALL Career Sea Pay for TDY.   

• Ensure the TDY dates match the member’s actual travel (use the 
PPC approved/finalized travel claim, not the orders). 

 Enter missing information in 
DA 

If TDY to a ship is missing from EABP, enter it into DA (even if the 
member is already on a ship).  Do NOT request PPC to enter missing 
TDY.  This is the P&A’s responsibility. 

 Review Admin Training Orders 
in DA 

If a period of TDY orders is found greater than 30 days, obtain the 
member’s actual dates using their Travel Claim and compare for 
accuracy.  Use the 30-day rule to account for start/stop of sea time 
dates. 

 Review travel history in ETS 
 
NOTE:  If the SEG 07 and travel 
claim dates do not match, 
verify the accuracy of the travel 
dates, and enter CSP for TDY 
into DA with the correct start 
and end dates. 

• Review the member’s travel history in ETS and attach any 
applicable travel claims to the SOCSS request.   

• Look for TDY over 30 days, including travel prior to 01 Jan 2015.   

• Ensure the travel claim dates and the SEG 07 match (see NOTE).   

• Enter any missing TDY to a ship into DA (even if Out-of-Range).  
Enter neutral rows for applying the 30-day rule. 

 

Print Name and Sign:   Date: 

mailto:PPC-DG-Customercare@uscg.mil
mailto:PPC-DG-Customercare@uscg.mil
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JUMPS Data Repository (JDR) to Excel Macro 

 
Introduction The JDR2Excel macro (JDR macro) is an Excel macro (automated task) that makes 

the JUMPS Data Repository (JDR) information easier to read.  No data is changed.  It 

simply clears out the non-relevant information and filters out the swapped segments 

giving you a clearer and faster read of the information, as well as the ability to sort 

and filter data. 

 

In order to use this tool, it must be added to the Excel Personal workbook.  This is a 

workbook that is always open and available in the background of Excel.  Storing the 

macro here allows it to be used by any workbook. 

 
JDR Access To obtain access to the JUMPS Data Repository (JDR), complete the CG-7421C 

JUMPS User Access Authorization form and submit to PPC Customer Care. 

 
Contents  

Topic See Page 

Adding a Macro to Your Personal Workbook 9 

Troubleshooting MACRO Errors 17 

Enclosure 1:  JDR2Excel Macro 23 

  

 

https://www.dcms.uscg.mil/Portals/10/CG-1/PPC/FORMS/cg_7421c.pdf?ver=2019-01-02-155645-823
https://www.dcms.uscg.mil/Portals/10/CG-1/PPC/FORMS/cg_7421c.pdf?ver=2019-01-02-155645-823
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Adding a Macro to Your Personal Workbook 

 
Introduction This section provides the procedures to add a Macro to your personal workbook in 

MS Excel. 

 
Procedures See below. 

 

Step Action 

1 Open MS Excel. 

 

2 Click Alt+F11 to open the Microsoft Visual Basic window.  This is where you will install the 

macro.  Check the Project box for the personal workbook (VBAProject 

(PERSONAL.XLSB)).  This one does not have it readily available.  If yours does, you may 

skip to Step 9.  

 
 

3 Go back to your Excel window.  Click File (the first option on the ribbon). 

 
 

 

Continued on next page 
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Adding a Macro to Your Personal Workbook, Continued 

 

Procedures, 

continued 
 

 

Step Action 

4 Choose Options (last item on the left-side list). 

 
 

5 Click on Customize Ribbon.  Make sure “Developer” is checked in the right-side box, then 

click OK. 

 
 

 

Continued on next page 
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Adding a Macro to Your Personal Workbook, Continued 

 

Procedures, 

continued 
 

 

Step Action 

6 Go to the Developer tab.  Click “Record Macro.” 

 
 

7 In the Record Macro dialogue box, ensure the Store macro in field displays “Personal 

Macro Workbook.”  If not, use the drop down to make that choice.  Click OK. 

 
 

8 Click “Stop Recording.” 

 
 

 

Continued on next page 
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Adding a Macro to Your Personal Workbook, Continued 

 

Procedures, 

continued 
 

 

Step Action 

9 Go back to the Microsoft Visual Basic window (Alt+F11). You should now see the Personal 

workbook (VBAProject (PERSONAL.XLSB)). Click the + sign to the left to expand it 

(expanded view shown). 

 
 

10 If there is not a Modules folder under the VBAProject (PERSONAL.XLSB) item, right-click 

on VBAProject (PERSONAL.XLSB).  Select Insert, then select Module.  If there is already 

a Modules folder there, proceed to Step 11. 

 
 

 

Continued on next page 
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Adding a Macro to Your Personal Workbook, Continued 

 

Procedures, 

continued 
 

 

Step Action 

11 Expand the Modules folder under VBAProject (PERSONAL.XLSB).  Double click on 

Module 1 to open it up. 

 
 

12 Highlight all the text (if any) in the macro window and delete it. 

 
 

 

Continued on next page 
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Adding a Macro to Your Personal Workbook, Continued 

 

Procedures, 

continued 
 

 

Step Action 

13 Copy ALL of the text from the Enclosure 1 and paste into the Macro window (where you just 

deleted text from).  Save and close the Microsoft Visual Basic window.  

 

VERY IMPORTANT:  Ensure all of the content is included. This content (Enclosure 1) is 

six pages long. The first line will be “Sub JDR2Excel()” and the last line will be “End Sub.”  

 
 

14 Click on the small down arrow beside the Quick Access Toolbar.  Select More Commands 

…. 

 
 

 

Continued on next page 
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Adding a Macro to Your Personal Workbook, Continued 

 

Procedures, 

continued 
 

 

Step Action 

15 Under “Choose commands from:”, select Macros.  A list of macros will appear.  Select 

PERSONAL.XLSB!JDR2Excel.  Click ADD > >. You will now see the command on the 

right side as well. Click on it in the right side window to highlight it. Click Modify… 

 
 

16 Select the icon you prefer to associate with the task.  Click OK. 

 
 

 

Continued on next page 
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Adding a Macro to Your Personal Workbook, Continued 

 

Procedures, 

continued 
 

 

Step Action 

17 To utilize, open the SEG (Segments 01, 07, 52, 57, 58, 62, or 81) and click the JDR’s Export 

to Excel button. 

 
 

18 Click Enable Editing.   

 
 

19 Click Enable Content, then click the macro button (icon selected in Step 16) in the top left 

of the page. 
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Troubleshooting MACRO Errors 

 
Purpose This section provides guidance on troubleshooting various macro errors you may 

encounter. 

 
Macro Not 

Available 
If you have previously installed the macro but it is no longer available to you, first 

check to see if it is still installed. 

 

Step Action 

1 With Excel open, use ALT+F11 to open the Microsoft Visual Basic window. 

 

2 Expand the Personal workbook.  (If the Personal workbook is missing, skip down to 

“MISSING PERSONAL WORKBOOK”.) 

 

3 Expand the Modules folder underneath it.  Double click any modules listed under the 

folder. 

 

4 What opens up should look like what you see below (the first line will be “Sub 

JDR2Excel()”). 

 
 

5 If none of them match, you will need to re-install the macro.  Follow the “Adding a Macro 

to Your Personal Workbook” instructions starting at Step 9. 

 

6 If it is still installed, you may just need to add it back to your Quick Access Toolbar.  Try 

following the “Adding a Macro to Your Personal Workbook” instructions starting at Step 14.  

 
 

Continued on next page 
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Troubleshooting MACRO Errors, Continued 

 
Missing Personal 

Workbook 
If you are having issues with the Personal workbook (it does not appear in the 

Microsoft Visual Basic window), try the two options below.  Sometimes the Personal 

workbook will disappear even though the macro has already been stored there.  This 

prevents you from using the macro button since the program can’t access the location 

where the commands are stored.  The below two options may help in this situation. 

 

Option 1 

Step Action 

1 In the Excel window, click File (the first option on the ribbon).  

 
 

2 Choose Options (last item on the left-side list). 

 
 

 

Continued on next page 



2 October 2023 
 

19 
 

Troubleshooting MACRO Errors, Continued 

 

Missing Personal 

Workbook, 

continued 

 

 

Step Action 

3 Click on Add-Ins.  Under Manage, use the drop down to select “Disabled Items,” and click 

Go…. 

 
 

4 If you see the Personal workbook listed, select it and click Enable.  Click Close, then click 

OK.  Now you can try again from either Step 9 (if the macro is not yet installed) or Step 14 

(if the macro is already installed) of the “Adding a Macro to Your Personal Workbook” 

instructions.  If not, just click Close. 

 
 

 

Continued on next page 
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Troubleshooting MACRO Errors, Continued 

 

Missing Personal 

Workbook, 

continued 

 

 

Option 2 

Step  Action 

1 In the Excel window, select the View tab.  Click Unhide.  

 
 

2 You should see the PERSONAL workbook listed.  Ensure it is highlighted and click OK. 

 
 

3 Select the Developer tab, then click Record Macro. 

 
 

 

Continued on next page 
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Troubleshooting MACRO Errors, Continued 

 

Missing Personal 

Workbook, 

continued 

 

 

Step Action 

4 In the dialogue box that appears make sure that under “Store macro in:”, it says “Personal 

Macro Workbook.”  If not, use the drop down to make that choice.  Click OK. 

 
 

5 Select Stop Recording. 

 
 

 

Continued on next page 
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Troubleshooting MACRO Errors, Continued 

 

Missing Personal 

Workbook, 

continued 

 

 

Step Action 

6 Go back to the Microsoft Visual Basic window.  You should now see the Personal 

workbook (VBAProject (PERSONAL.XLSB)). 

 
 

7 Go back to the Excel window.  Under the View tab, click Hide.  The viewable Personal 

workbook (as a spreadsheet) will disappear.

 
 

8 Now you can try again from either Step 9 (if the macro is not yet installed) or step 14 (if the 

macro is already installed) of the “Adding a Macro to Your Personal Workbook” 

instructions. 
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Enclosure 1:  JDR2Excel Macro (** From the toolbar, under View > Page Display, 

select Enable Scrolling to allow you to copy and paste the entire data string.**) 

 

Sub JDR2Excel() 
'Converts information from the Access application JDR (JUMPS Data Repository) into an easier 
to read format in Excel. It deletes unnecessary columns, filters out swapped rows (dates), and 
sorts the information by chronological order. 
 
On Error GoTo Error_Handler: 
 
Application.ScreenUpdating = False 
 
Rows("1:1").Delete 
 
Dim LR1 As Long 
LR1 = Cells(Rows.Count, 1).End(xlUp).Row 
     
If Range("B2").Value = 1 Then 
'SEG 01 (Basic Pay) 
'Also calculates points earned and sorts them by reserve point category (column). 
     
    Range("A:V,X:X,Z:AB,AD:AD,AF:BE").Delete Shift:=xlToLeft 
    Columns("C:C").Select 
    Selection.Cut 
    Columns("E:E").Select 
    Selection.Insert Shift:=xlToRight 
    Columns("D:D").NumberFormat = "0"".""00;-0"".""00;0"".""00" 
     
    Range("E1").FormulaR1C1 = "IDT" 
    Range("F1").FormulaR1C1 = "RMP" 
    Range("G1").FormulaR1C1 = "FD" 
    Range("H1").FormulaR1C1 = "AD" 
    Range("I1").FormulaR1C1 = "TRUE" 
     
    Range("E2:E" & LR1).Formula = "=IF(A2<>B2,0,IF(OR(C2=""M "",C2=""D "",C2=""F 
"",C2=""W "",C2=""Y "",C2=""Z ""),2,IF(OR(C2=""S "",C2=""E "",C2=""H "",C2=""J "",C2=""X 
""),1,0)))" 
    Range("F2:F" & LR1).Formula = "=IF(AND(A2=B2,OR(C2=""A "",C2=""N "")),1,0)" 
    Range("G2:G" & LR1).Formula = "=IF(AND(A2=B2,OR(C2=""G "",C2=""H "",C2=""J "")),1,0)" 
    Range("H2:H" & LR1).Formula = 
"=IF(AND(B2>=A2,OR(C2=""1P"",C2=""2P"",C2=""3P"",C2=""4P"",C2=""6P"",C2=""1A"",C2=""2
A"",C2=""3A"",C2=""4A"",C2=""6A"",C2=""1Y"",C2=""2Y"",C2=""3Y"",C2=""4Y"",C2=""6Y"",C2=""
1N"",C2=""2N"",C2=""3N"",C2=""4N"",C2=""6N"",C2=""7Y"",C2=""8Y"",C2=""9Y"",C2=""TY"",C2=
""UY"",C2=""VY"")),DATE(LEFT(B2,4),MID(B2,5,2),RIGHT(B2,2))-
DATE(LEFT(A2,4),MID(A2,5,2),RIGHT(A2,2))+1,0)" 
    Range("I2:I" & LR1).Formula = "=IF(B2<A2,0,1)" 
     
    With ActiveWindow 
        .SplitColumn = 0 
        .SplitRow = 1 
    End With 
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    ActiveWindow.FreezePanes = True 
    Range("A1").Select 
    Selection.AutoFilter 
        ActiveSheet.Range("$A$1:$I" & LR1).AutoFilter Field:=9, Criteria1:="1" 
    Range("A2").Sort Key1:=Range("A2"), Order1:=xlDescending, Header:=xlGuess, 
OrderCustom:=1, MatchCase:=False, Orientation:=xlTopToBottom 
    Cells.EntireColumn.AutoFit 
 
    Exit Sub 
 
ElseIf Range("B2").Value = 7 Then 
'SEG 07 (Career Sea Pay) 
 
    Range("A:V,X:X,Z:AC,AF:AI").Delete Shift:=xlToLeft 
     
    Range("E1").FormulaR1C1 = "TRUE" 
    Range("E2:E" & LR1).Formula = "=IF(B2<A2,0,1)" 
     
    With ActiveWindow 
        .SplitColumn = 0 
        .SplitRow = 1 
    End With 
    ActiveWindow.FreezePanes = True 
    Range("A1").Select 
    Selection.AutoFilter 
    ActiveSheet.Range("$A$1:$E" & LR1).AutoFilter Field:=5, Criteria1:="1" 
    Range("A2").Sort Key1:=Range("A2"), Order1:=xlDescending, Header:=xlGuess, 
OrderCustom:=1, MatchCase:=False, Orientation:=xlTopToBottom 
    Cells.EntireColumn.AutoFit 
     
    Exit Sub 
 
ElseIf Range("B2").Value = 52 Then 
'SEG 52 (Permanent Unit) 
 
    Range("A:V,X:X,Z:AB,AE:AG").Delete Shift:=xlToLeft 
     
    Range("E1").FormulaR1C1 = "TRUE" 
    Range("E2:E" & LR1).Formula = "=IF(B2<A2,0,1)" 
     
    With ActiveWindow 
        .SplitColumn = 0 
        .SplitRow = 1 
    End With 
    ActiveWindow.FreezePanes = True 
    Range("A1").Select 
    Selection.AutoFilter 
    ActiveSheet.Range("$A$1:$E" & LR1).AutoFilter Field:=5, Criteria1:="1" 
    Range("A2").Sort Key1:=Range("A2"), Order1:=xlDescending, Header:=xlGuess, 
OrderCustom:=1, MatchCase:=False, Orientation:=xlTopToBottom 
    Cells.EntireColumn.AutoFit 
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    Exit Sub 
     
ElseIf Range("B2").Value = 57 Then 
'SEG 57 (Pay Status) 
     
    Range("A:V,X:X,Z:AB,AE:AK").Delete Shift:=xlToLeft 
     
    Range("E1").FormulaR1C1 = "TRUE" 
    Range("E2:E" & LR1).Formula = "=IF(B2<A2,0,1)" 
     
    With ActiveWindow 
        .SplitColumn = 0 
        .SplitRow = 1 
    End With 
    ActiveWindow.FreezePanes = True 
    Range("A1").Select 
    Selection.AutoFilter 
    ActiveSheet.Range("$A$1:$E" & LR1).AutoFilter Field:=5, Criteria1:="1" 
    Range("A2").Sort Key1:=Range("A2"), Order1:=xlDescending, Header:=xlGuess, 
OrderCustom:=1, MatchCase:=False, Orientation:=xlTopToBottom 
    Cells.EntireColumn.AutoFit 
     
    Exit Sub 
     
ElseIf Range("B2").Value = 58 Then 
'SEG 58 (Pay Grade) 
     
    Range("A:V,X:X,Z:AB,AF:AG").Delete Shift:=xlToLeft 
     
    Range("F1").FormulaR1C1 = "TRUE" 
    Range("F2:F" & LR1).Formula = "=IF(B2<A2,0,1)" 
     
    With ActiveWindow 
        .SplitColumn = 0 
        .SplitRow = 1 
    End With 
    ActiveWindow.FreezePanes = True 
    Range("A1").Select 
    Selection.AutoFilter 
    ActiveSheet.Range("$A$1:$F" & LR1).AutoFilter Field:=6, Criteria1:="1" 
    Range("A2").Sort Key1:=Range("A2"), Order1:=xlDescending, Header:=xlGuess, 
OrderCustom:=1, MatchCase:=False, Orientation:=xlTopToBottom 
    Cells.EntireColumn.AutoFit 
     
    Exit Sub 
 
ElseIf Range("B2").Value = 62 Then 
'SEG 62 (LEAVE ACCRUAL) 
 
    Range("A:M,O:V,X:X,Z:AB,AV:BE,BH:BP").Delete Shift:=xlToLeft 
    Columns("B:C").Cut 
    Range("A1").Insert Shift:=xlToRight 
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    Columns("L:L").Cut 
    Range("K1").Insert Shift:=xlToRight 
    Columns("H:X").NumberFormat = "0"".""0;-0"".""00;0"".""0" 
 
    Range("Y1").FormulaR1C1 = "TRUE" 
    Range("Y2:Y" & LR1).Formula = "=IF(B2<A2,0,1)" 
 
    Cells.EntireColumn.AutoFit 
    With ActiveWindow 
        .SplitColumn = 0 
        .SplitRow = 1 
    End With 
    ActiveWindow.FreezePanes = True 
    Range("A1").Select 
    Selection.AutoFilter 
    ActiveSheet.Range("$A$1:$Y" & LR1).AutoFilter Field:=25, Criteria1:="1" 
    Range("A2").Sort Key1:=Range("A2"), Order1:=xlDescending, Header:=xlGuess, 
OrderCustom:=1, MatchCase:=False, Orientation:=xlTopToBottom 
  
    Exit Sub 
 
ElseIf Range("B2").Value = 69 Then 
'SEG 69 (CUMULATIVE SEA DUTY ADJUSTMENT) 
 
    Range("A:H,J:O,Q:V,X:X,Z:Z,AJ:AK").Delete Shift:=xlToLeft 
 
    Cells.EntireColumn.AutoFit 
    With ActiveWindow 
        .SplitColumn = 0 
        .SplitRow = 1 
    End With 
    ActiveWindow.FreezePanes = True 
    Range("A1").Select 
    Selection.AutoFilter 
  
    Exit Sub 
 
ElseIf Range("B2").Value = 81 Then 
'SEG 81 (Reserve Points) 
     
    Range("A:V,X:X,Z:AE,BV:BW").Delete Shift:=xlToLeft 
     
    Range("A1").FormulaR1C1 = "FROM" 
    Range("B1").FormulaR1C1 = "TO" 
    Range("C1").FormulaR1C1 = "SVC" 
    Range("D1").FormulaR1C1 = "QUAL SVC" 
    Range("E1").FormulaR1C1 = "REG AD" 
    Range("F1").FormulaR1C1 = "RSV AD" 
    Range("G1").FormulaR1C1 = "IDT" 
    Range("H1").FormulaR1C1 = "RMP" 
    Range("I1").FormulaR1C1 = "MBR" 
    Range("J1").FormulaR1C1 = "CC" 
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    Range("K1").FormulaR1C1 = "SUB TOT" 
    Range("L1").FormulaR1C1 = "ADJ TOT" 
    Range("M1").FormulaR1C1 = "TOTAL" 
    Range("N1").FormulaR1C1 = "CC1" 
    Range("O1").FormulaR1C1 = "CC1 DATE" 
    Range("P1").FormulaR1C1 = "CC1 PTS" 
    Range("Q1").FormulaR1C1 = "CC2" 
    Range("R1").FormulaR1C1 = "CC2 DATE" 
    Range("S1").FormulaR1C1 = "CC2 PTS" 
    Range("T1").FormulaR1C1 = "CC3" 
    Range("U1").FormulaR1C1 = "CC3 DATE" 
    Range("V1").FormulaR1C1 = "CC3 PTS" 
    Range("W1").FormulaR1C1 = "CC4" 
    Range("X1").FormulaR1C1 = "CC4 DATE" 
    Range("Y1").FormulaR1C1 = "CC4 PTS" 
    Range("Z1").FormulaR1C1 = "CC5" 
    Range("AA1").FormulaR1C1 = "CC5 DATE" 
    Range("AB1").FormulaR1C1 = "CC5 PTS" 
    Range("AC1").FormulaR1C1 = "CC6" 
    Range("AD1").FormulaR1C1 = "CC6 DATE" 
    Range("AE1").FormulaR1C1 = "CC6 PTS" 
    Range("AF1").FormulaR1C1 = "CC7" 
    Range("AG1").FormulaR1C1 = "CC7 DATE" 
    Range("AH1").FormulaR1C1 = "CC7 PTS" 
    Range("AI1").FormulaR1C1 = "CC8" 
    Range("AJ1").FormulaR1C1 = "CC8 DATE" 
    Range("AK1").FormulaR1C1 = "CC8 PTS" 
    Range("AL1").FormulaR1C1 = "CC9" 
    Range("AM1").FormulaR1C1 = "CC9 DATE" 
    Range("AN1").FormulaR1C1 = "CC9 PTS" 
    Range("AO1").FormulaR1C1 = "CC10" 
    Range("AP1").FormulaR1C1 = "CC10 DATE" 
    Range("AQ1").FormulaR1C1 = "CC10 PTS" 
    Range("AR1").FormulaR1C1 = "FHD" 
     
    Columns("C:C").Cut 
    Range("A1").Insert Shift:=xlToRight 
    Columns("J:J").Cut 
    Range("G1").Insert Shift:=xlToRight 
    Columns("AR:AR").Cut 
    Range("M1").Insert Shift:=xlToRight 
    Columns("E:F").Cut 
    Range("N1").Insert Shift:=xlToRight 
    Columns("D:D").Cut 
    Range("O1").Insert Shift:=xlToRight 
 
    Range("AS1").FormulaR1C1 = "TRUE" 
    Range("AS2:AS" & LR1).Formula = "=IF(C2<B2,0,1)" 
     
    With ActiveWindow 
        .SplitColumn = 0 
        .SplitRow = 1 
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    End With 
    ActiveWindow.FreezePanes = True 
    Range("A1").Select 
    Selection.AutoFilter 
    ActiveSheet.Range("$A$1:$AS" & LR1).AutoFilter Field:=45, Criteria1:="1" 
    Range("B2").Sort Key1:=Range("B2"), Order1:=xlAscending, Header:=xlGuess, 
OrderCustom:=1, MatchCase:=False, Orientation:=xlTopToBottom 
     
    With Cells 
        .EntireColumn.AutoFit 
        .WrapText = False 
    End With 
    With Range("H:H,I:I,M:M").Interior 
        .Color = 14540253 
    End With 
    Range("A1").Select 
     
    Exit Sub 
     
     
Application.ScreenUpdating = True 
     
Else: MsgBox ("This macro will only convert JDR segments 1, 7, 52, 57, 58, 62, 69, and 81. 
Either there are no entries in this SEG or the conversion process for this SEG was not included 
in the macro.") 
 
End If 
 
Exit Sub 
 
Error_Handler: 
MsgBox ("An error has occurred. Please try again on a new sheet.") 
 
End Sub 
 

 


